Hammersley Road
Resurfacing 2022

Public Informational Meeting

by City of Madison Engineering Division
Tuesday, February 8t 2022 &
Wednesday, February 9t" 2022




X

This meeting will be recorded and posted to the City’s project page.
All attendees should stay be muted to keep background noise to a
minimum.

You may use the “raise hand” option at the bottom if you have
something that required immediate clarification.

Use “chat” option if you are having technical issues and a staff person
can try to assist.

Please use the “Q&A” option at the bottom of the screen to type your

qguestion. Questions will be answered at the end of the presentation.
Inappropriate questions may be dismissed.




This meeting is being recorded.
It is a public record subject to disclosure.

By continuing to be in the meeting, you are consenting to being
recorded and consenting to this record being released to public
record requestors.
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Presentation Overview

» Project Limits & Scope

» Existing Roadway Conditions & Data

» City Policies and Adopted Plans

» Proposed Street Work & Design (2022 & 2023 Project)
» Overview of Underground Utilities (2022 Project-Only)
» Forestry Information

» Assessment Policy & Cost

» General Construction Info

» Anticipated Schedule

> Q&A




Project Location
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Scope of Work

» Replace City Utilities
»Sanitary Sewer Main & Laterals

»Storm Sewer
»Water Main

»MG&E Gas Replacement
> Separate from City Project

» Replace Street Infrastructure as needed
»Asphalt Pavement (replace all)

»Curb & Gutter

»Driveway Aprons

»Sidewalk & Pedestrian Ramps




Existing Condition of Hammersley Rd

_ Existing Condition

Pavement Surface Brookwood Rd to W Beltline Frontage Rd =4

Rating (Out of 10)

Curb (Out of 10) Brookwood Rd to W Beltline Frontage Rd = 7

Sidewalk No Continuous Sidewalk on Either-Side

Width (Curb-to-Curb) Brookwood Rd to Whitney Way =36’ | Whitney Way to W Beltline Frontage Rd = 40’
Traffic Brookwood Rd to Whitney Way - Avg Speed = 25 mph | Avg Volume = ~3200 Cars/Day
Volumes/Speeds Whitney Way to Gilbert Rd - Avg Speed = 19 mph | Avg Volume = ~1400 Cars/Day

Gilbert Rd to Reetz Rd - Avg Speed = 24 mph | Avg Volume = ~3000 Cars/Day

On-Street Parking Brookwood Rd to Whitney Way = Parking Allowed on Both Sides
Whitney Way to W Beltline Frontage Rd = Parking Allowed on Northside-only

On-Street Bike Lanes Brookwood Rd to Whitney Way = No On-Street Bike Lanes
Whitney Way to W Beltline Frontage Rd = On-Street Bike Lanes Both Sides




v =+ Uy h\-‘-';j' LR IHQ -
A Streetllght Data
:amb rchard
Madison Tasting Rc | v Ridge Park
David Schrankler - @
FoodSafetyMadisor ifz&
Sherwood @4‘7?);.
; TSI _,;‘"'ﬁ H Gilbert to O @”’@
& — ; Suffolk & & : Lewon ““[Lewon to
centres Ry a ) I-I ’ Orchard Ridge ;;I[grrs 380 Psychic Servic ;irgr_rh Loruth to / 700
Cnark .y . /
Brookwood tojal Services S Whitney 2020: 2,735 2019: 3.383 Whitcomb -
B T omb [MDT Whltcomb
Bipoes S Whitney to Gilbert 2020: 2,731|,
,o i AADT \ ) r— Apart2019: 3,316 to Reetz
& 2019: 3,459 ; 2018: 1.573 | / 2 2020: 2,747 QAI;DQTS 384
ane 2020: 2,868 2 2020 1’150 _I / D9
’ -1 | : .
rackers Hammersley = : ' 2020rl.1§5]8|5?m Sunnah
e Center Park :;‘ BTM Propert |u~° / i i
T it | Q ;S{Jb-Zem G
Goodwill Madison
Verona Road
slilista lucho arias q Pl Planet Fitne
Erookwood [Coruth to
23 s g“'h'tr:ie}’ = giT:I;:'ttn:ggm Gilbert to Lewon to ~ |Whitcomb Whitcomb to
Vg Spee <7 Lewon Av Loruth Av - |Avg Speed Reetz Av
A 2019: 24 mph s [Speed Madison 0 Speed ] Speed 9 F 20199: EPB mph| 1Speed Tl
2020: 26 mph 2019: 18 mphfite Church ¥ 12019: 23 mph 2019: 24 mph 2020: 24 mph| 2019: 22 mph
= Brookwood to ,12020: 19 mph o f2020: 24 mph| o (2020: 24 mph] Coruth o 2020: 23 mph
-|S Whitney g_"l";h““;gz? Gilbert to Lewon to Whitcomb Whitcomb o
(2020 | iIbert | Lewon 2020 Loruth 2020 ~ [2020 Reetz 2020
=30 —0407 ["-: bsugo; 79 hool 3(;,30 =399 I’ ~30 = 405 a Consulting [>30 = 464 <30 = 522
(142%) A e (14.6%) (14.8%) Q [ne-9%) (18.6%)
. 3{; xc__ o T =40 =200 =40 = 206 >40 =246 >40 = 282
(6.3%) z |(2.7%) (7.3%) (7.5%) F1a{(8.9%) (10.1%)

Hammersley Rd Speed Limit (West of Whitney Way) =
(East of Whitney Way)

25 mph
30 mph




- A agh - |u|é n"‘u_’f ] U!‘\'HIH = ' U'Juﬂl
Thgebury Ct :
- & Services

: ! ~IWeekday Parking Data

2
e

Madison Tg

David Schrankler - @
FoodSafetyMadison J’I/g

Ro: ~svenportD) Sherwood S
K f_— . - {.o
Forest Park G o ek

| S Whitney & [ Whitney Gilbert to Lewon 10 Coruth to

Groentree Ry ,.“ North Side % to G||bert Orchard Ridge Lewon . Psychic S¢ Loruth ] Whitcomb
< Prem L ark North Side North Side North Side North Side

! “ om0 bal Services AM: 1 AM: 3 AM: O ; AM: 0

BM- 1 PM: 0 PM: 0 Vhitcompy: g

|- Piping Rock Rd __;‘ _; Westhisry Pl Whitcomb D \WRHEomm D Ap
- B (%) o = |
= f - 3 s |
Sunridge Park B = . | ki
I'._ ,l et { Rd T= r:_': Ham a : | -
ackers Hammersley 5 g Masjid us Suhnahe
: Center “Park g BTM Properties Q N
MRy Rl Hammersley Rd Hammersiey Rd Hammessley Rd Vetona Rd. q Sub-zergic
m g S ? .
g . 5 1 Goodwill Madison
“ g Verona Road
HESE U i9s 9 a0V Dorsett Dr Doreett Dr Dorsett Dr MOCpa LY Paul Ave Planet Fitn
o %) 4
Brookwood <) =
coba Wy to S Whitney S, Toimon Terrace _ 0 : L
South Side = Madison & The Home Depot
3 ; i Mennonite Church Marvin Ave
AM: 0 e
— = — \\.x'-' T r_ PM 1 parton Rd Barton Rd Ridgewood POO‘Q Rarian'Rd T
: a Toki Preschool St. Maria Goretti Q ~ TaxDiva Consulting | e
M > Forest Cathalic Church J bl Q Stor:
Loms: =| = J: |-__‘ E 1 | ]

E : 2 ’ Flad Park

"“Pa;rkiﬁg Data Collected over oneuWeekJanuary 2022




v

ickers
Center

ilista lucho arias 9

Lomax Ln

v = ofy, igsbury C1 LUy MAYray 1YY o - Upaarc
Qi & Services :
= Cambrid H
LWeekend Parking Data
L
David Schrankler - @
o i - FoodSafetyMadison f‘}/&e
venport D erwoo , K
Forest Park W 3 la, oy
8 Brookwood to & Ty :
S Whitney _\@ S Whitney Gilbert to Lewon to Loruth to Whitcomb
3 Groenree R £ [North Side & to Gilbert Orchard Ridge {LeWon boychic s{oruth Whitcomb to Reetz 7o
7 Pk hark North Side North Side North Side North Side North Side J
| A 5 L3l Sarvices AM: 3 AM: 0 AM: 0 o AM: 0 AM: 2
. Pping RockRd 3 . PM: 5 PM: 0 PM:0_ ["oTlPM: 0 PM: 0
n z esth P hitcomb D Whitcomb
h : = 5 .' :
sunridge Patk 4 = g 5 ' ]
. ", Hempstead Rd - g Hempstaad Rd & ) 'I i
Hammersley s Masjid us-Sunnah Q
Park B BTM Properiieso o,
T Hammersley He Hammersley Rd Hammersley Rd lan v Rel Vet ona R4 Qéub'ZEIO Gr
= % 7 .
" 5 : Goodwill Madison
5 B 2 Verona Road
Jorsett D gtt O et Paul Ave Planet Fitne
b S
Brookwood 5 ? i '
vy to S Whitney = fiidoe 0 2
: © Madison The Home Depot |
SaISide = Menn f1il| Ef‘ rch 4 Marvin Ave | d
AM: O ennonite Churc 7 .
— ’ g ._g.'-‘l':'J : PM O [+ Rd Bart Rd Ridgewood pODI 9 Aatenad Y I'
: A Toki Preschool St. Maria Goretti o _ Tax Diva Consulting | U-Hat
o ‘:—) Forest Catholic Church ¥ Fophiis Q Fidd A Stora
& - - 1 :: 2 I'
; g z _ Flad Park '

"“Parrki'hg Data Collected over One Week January 2022




EXISTING — BROOKWOOD RD TO WHITNEY WAY

36’
EXISTING FACE-TO-FACE




EXISTING = WHITNEY WAY TO BELTLINE




Existing Cond

Whitney to Beltline

" Brookwood to Whitney
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2018 Madison Comprehensive Plan
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> Long-Term Growth  "=rieeve
Framework

Existing Sidewalk on One Side of Street

Mo Existing Sidewalk
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Mote: Tier 1 sidewalks are a priority for filling in existing gaps in the X
City’s pedestrian network because they are close to schools, transit routes,
or along other features that attract pedestrians. City of Madison policy
is that all streets should have sidewalks on both sides of the street.
El

e
» Hammersley Road
»ldentified as Tier 1
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ensus Buresu: City of Madison Planning Division
Dete Pringed: 9/17/2018
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City Policies and Adopted Plans

What informs our street design?

» Policies and plans help prioritize and guide designs to
provide safe transportation options for everyone

» Variety of City policies, plans, reports and organizations
guide street design
- Complete Streets

Madison in Motion UISIUN ZEHU

Comprehensive plan

Pedestrian and Bicycle Plans M-A D 5 0 N

Vision Zero
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Project Goals

Safety for all users

v

- Develop a design that focuses on improving safety

> Maintaining slower speeds

v

Review roadway characteristics for use by bicyclists
- Provide a network for cyclists of all ages & abilities

> Increase number of people biking

v

Improve pedestrian network

- Improve overall feeling of comfort while walking
- Increase accessibility for all abilities

> Increase number of people walking

Provide reliable, durable infrastructure




Proposed Design - Goals

» Keep All Proposed Street Changes within Existing Width
»Avoid Substantial Tree Loss
»Avoid Major Grading Impacts

> Provide Safe Facilities for Bikes & Pedestrians
»People of all Ages & Abilities

» Metro Redesign - Ongoing
»>Need for Better Pedestrian Facilities
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PROPOSED — BROOKWOOD RD TO WHITNEY WAY
NORTHSIDE MULTI-USE PAT
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EXISTING = WHITNEY WAY TO BELTLINE




PROPOSED — WHITNEY WAY TO BELTLINE
NORTHSIDE MULTI-USE PATFE
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Proposed Design
» Remove ALL On-Street
Parking & Bike Lanes
» Reconstruct Northside Curb
> 24’ Wide Street
» Two-Way, 10’ Travel Lanes

> Install 9-10° Off-Street,
Multi-Use Path (Bikes+Peds)

» Grass Terrace Width Vary (3-6’)
» Path Centerline Markings
» “Share the Path” Signage

» Lighting Improvements
» Use Existing Poles

> Path Specific Lighting
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*Example Hammersley Overwew East of Whltney Way




Proposed Design
» Cost to Construct Path would be Covered 100% by the City

» Typical New Sidewalk is Charged 100% to Fronting Property Owner
> Assessments would be Similar to Typical Resurfacing Project.

» Path would be Maintained by the City (Shnow Removal)
» Typically, Fronting Property Owner shovels sidewalk

» Fronting Property Owner would STILL be responsible for Maintaining Grass Terrace
between Path and Curb

» Street Crossings at 4-Way & T-Intersections to Access Multi-Use Path
» Pedestrian Ramps and Pavement Markings

» 2023 Project would Connect to Southwest Path at the Beltline




Proposed Design — Whitney Way Path Crossing

» Traffic Engineering is
collecting Data and
Analyzing Potential Path
Crossing Alternatives

» Potential Options
>RRFB

»Signalized Intersection
»Median Island Changes

OFF-STREET, MULTI-USE PATH CROSSING



Proposed Design — Whltney Way Path Crossing

> Potential Option
»>Combine Northside Medians

»Remove Left-Turns from
Eastbound Hammersley onto
Northbound Whitney Way

>Turning Count Under Data Review $77

» U-Turn at Dorsett Dr

»Shortens & Straightens
Path Crossing

»Limits Potential Conflicts

»>RRFB

COMBINE
MEDIAN
ISLANDS

PATH'

WHITNEY WAY

ko

R
HAMMERSLEY RD




Preliminary Survey Results
> 103 responses so far (Wow - Thank you!)

» Issues related to specific properties will be reviewed in
more detail in near future

» Proposed Changes = Street Narrowing & Path Installation

»Overall 72% Support Change
»Concerns about Parking Removal

~ Survey remains open until Wednesday, March 2nd

» Rethinking your survey answers - email me (Aaron)
»Contact Info on last slide




City Utility Work — Sanitary Sewer
» Existing Sanitary sewer

»Hammersley Rd (Brookwood Rd to Gilbert Rd)
> Installed 1950s | 8” Diameter, Vitrified Clay Pipe

» Proposed Sanitary Sewer
o Replace Sanitary Main with minimum 8” PVC Pipe

o Replace Sanitary Laterals from Sewer Main to Property Line with 6” PVC Pipe

o Potential to replace laterals at the curb to avoid Tree impacts = City will evaluate and
follow-up with individual property owners

» Backyard Sanitary Sewer (5718, 5714, 5710, 5706 Hammersley)

» Connected to Existing Sanitary on Hempstead Rd
» City is Evaluating the Feasibility to Serve these Lots off of Hammersley Sewer Main
> Need Survey of Basement/Lowest Floor Elevations

> Impacted Properties = Please Stay on After Q&A (If not yet contacted) or Contact Lauren
triegl directly at
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mailto:Lstriegl@cityofmadison.com

City Utility Work — Sanitary Sewer Laterals

Limits of construction projects are typically
to the property line. City will NOT replace
sanitary lateral beyond this point.

PrivatelSanitary/l'ateral

e
i\

-l :'l =
- {Anyjwork{on[private)
_(Bropetityjisithe)

homeownerss

responsibility,

City will replace a
private sanitary lateral
UP TO THE PROPERTY LINE
during a sanitary sewer
replacement project

Private Sanitary/Connection
T .
. .

Sanitary Sewer
Laterals




City Utility Work — Storm Sewer

» EXisting Storm Sewer
»Hammersley Rd (1100’ on Hammersley, West of Whitney Way)

» Installed 1960s | 18" RCP
» Storm Sewer throughout Hammersley-Whitney Way Intersection

»Hammersley Rd (450’ on Hammersley, East of Gilbert Rd)
> Installed 1950s | 15” Clay Pipe
» Storm Sewer at Hammersley-Gilbert Intersection
» Storm Sewer Culvert under Road at Hammersley Park
> Installed 1970s | 30" Corrugated Metal Pipe
» Storm Sewer Culvert under Road at 5522/5513 Hammersley

» Proposed Storm Sewer
- Replace & Upgrade all Existing Storm Sewer with RCP
- Add Storm Sewer at Enclosed Depressions - Pipe 100-yr Event
> Terrace Inlets at Low Points = Potential Tree Removals

> Potentially Replace & Upgrade Storm Sewer Culvert Crossings




City Utility Work — Water Main

Existing Water Main

»Hammersley Rd (Brookwood Rd to Gilbert Rd)
> Installed 1950s | 6-Inch Diameter Cast Iron

Proposed Water Main
» Replace All Water Main with New, 12-Inch Diameter Ductile Iron
» 0Old Fire Hydrants will be replaced - 600’ Max. Spacing

» Existing Water Service Laterals will be Disconnected from the Old Main and Reconnected to
New Main within Street Right-of-Way.

Impacts from Water Installation

» 2-3 Planned Water Service Outages (~6 hrs) for Residents along Hammersley Rd

> All planned service disruptions will have 2 days advance notice, typically Contractor puts up door
hangers

» Potential Unplanned Water Service Outages, Contractor will notify Residents and Repair
Damages ASAP

» Construction may cause Temporary Discolored Water Events. Please see link for more info


https://www.cityofmadison.com/water/water-quality/discolored-water

Forestry Information

> Tree Removals (Brookwood to Beltline to occur in 2022)

» Due to Condition:
» 20" Boxelder (5909 Hammersley)
» 247 Black Cherry (5701 Hammersley)
> 15" White Oak (5609 Hammersley)
> 9” Bur Oak (1302 Gilbert Rd)
> 36" White Oak (5714 Hammersley)
» 35”7 Silver Maple (5313 Hammersley)
» 20" Norway Maple (5217 Hammersley)
> 16" Green Ash (5222 Hammersley)

» Potential Removals (Pending Further Forestry Evaluation):
> 117 Black Walnut (5518 Hammersley Rd)
> 18" White Oak (5718 Hammersley)
> 40" Bur Oak (5314 Hammersley)

» Due to Utilities:
> 417 Black Walnut (5709 Hammersley)
DURURRRRRRRRRRRRRRRRRRRRRRR R T~ Ty




Forestry Information

» Tree Pruning prior to Construction = within the Next Month
»Within 2022 Project Limits (Brookwood to Gilbert)

» Shrubs & Other Items in Right-of-Way Potentially Removed
> Property Line = Varies 10-15’ behind existing back-of-curb

> Preserve Trees that will Remain
»Hand-formed curb
»Bend & limits of work for sewer laterals

~ Forestry will Review for New Plantings after Construction




Assessment Policy & Costs

Replace curb & gutter* 50% 50%
Asphalt Pavement* 0% 100%
Replace sidewalk 50% 50%
Replace driveway apron* 50% 50%
New Sidewalk 100% 0%
ADA compliant sidewalk ramps 0% 100%
Storm sewer 0% 100%
Private Storm Connects, if any 100% 0%
Sanitary Sewer Main 0% 100%
Sanitary Sewer Laterals 25% 75%
Water Main & Services 0% 100%
Street Trees Removals & Plantings 0% 100%

*Necessary work for multi-use path installation will NOT be assessed




Assessment Policy & Costs

» Preliminary, estimated assessments mailed prior to project

» Final assessments calculated following construction using
measured quantities and actual bid prices
- Final billing sent in summer after construction (2023 for this project)

» Assessments are payable in lump sum or in up to 8
installments at current interest rate (2% )




Construction, Access, and Impacts

» Hammersley Road will be closed to thru-traffic during construction
» Local Roadway & Driveway* Access will be Maintained
» Metro Buses 18, 51, School Service = Posted Detours (Likely use Dorsett Dr)

» Standard work hours 7am-7pm Mon-Sat; 10am-7pm Sun

» Any existing landscaping within Right-of-Way will likely be disturbed
» Anything you wish to save should be removed prior to construction

» Project will require temporary water shut-offs

» Contractor will need to pump ground water

> Keep utility trenches dry and safe to complete utility work
» Pumps will likely need to run over night

~ Best guess construction timeframe: June 2022 thru Oct 2022
> MG&E’s work could extend construction timeframe




Anticipated Project Schedule

» 01/12/2022: Transportation Commission, Preliminary Review

» 02/18/2022: Mail Estimated Assessments, BPW Public Hearing Notice
» 02/23/2022: Transportation Commission, Final Approval (held virtually)
» 03/02/2022: BPW Public Hearing (held virtually)

» 03/15/2022: Common Council Hearing (held virtually)

» 03/24/2022: Advertise for Bids

» 06/20/2022: Begin Construction

» 10/21/2022: Approx. End Construction




Contact Information & Resources

» City Staff Contacts:

Aaron Canton, PM/Streets Designer, 608-242-4763, acanton@cityofmadison.com

Lauren Striegl, Storm & Sanitary Designer, 608-266-4094, | Striegl@cityofmadison.com

Kelly Miess, Water Designer, 608-261-9640, KVliess@madisonwater.org

Gretchen Aviles Pineiro, Electrical Designer, 608-266-4899, GAvilesPineiro@cityofmadison.com

Jeremy Nash, Traffic Engineering, 608-266-6585, [nash@cityofmadison.com
Jeff Heinecke, City Forestry, 608-266-4890, jheinecke@cityofmadison.com

> Project Website: https://www.cityofmadison.com/engineering/projects/hammersley-
road-resurfacing

» Sign-up for project email updates on the website
* Updates on closures & work progress will be posted to the project website
* Survey will remain open until 03/02/2022

» Facebook — City of Madison Engineering
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